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1. To Get a New Pass Word
If you forgot your password, you will have to request a new one. Bring your Wes ID to the Help Desk in
the Science Center Computer Lab, Room SC 147. Your request will be processed within 24 hours.

2. To Get to ITS Help Tip Sheets
For information on a variety of computer topics, such as How to use Eudora, How to download
Attachments in Pine, Start up Netscape. Delete what is in the Location EditWindow and type HelpDesk.
Then click on Tip Sheets.

3. To logon to computers in SC72 Computer Classroom:
This classroom uses G3-Macintosh Computers, but we will be running a “virtual PC” on them.
That is to say, we shall run Windows 95 on top of the Macintosh!
Here is how to proceed:
1. If the computer display is blank, then you should push the “Start Up” key located on the upper right
hand corner of the keyboard; it has a triangle on it.
2. Click the pretty Apple in the upper left-hand corner of the screen.
3. Select virtual PC – This will start Windows 95 (wait patiently for the login screen)
4. Now you log in (e.g. if your name is Adam Smith then your email address is ASMITH and your class
is 01 you type .asmith.a.s01.wu note that there are 4 periods. Faculty use .mlovell.econ.wu)
5. When the WHOAMI box comes up, get rid of it by clicking in the upper right-hand corner and if
asked, strike a key to continue.

HowTo.Doc
6.

(Mike Lovell)

page 2

If it asks you to confirm a new password, click on the cancel box.

Notes:
1. The Macintosh uses a One Button Mouse: To right click you hold down the shift key and click the
mouse.
2. It is possible for you to fall out of Windows back into the Apple mode. If this happens to you, hold
down the Apple key, hit Control, and then toggle the Screen Mode.

4. To Logout:
You must logout in order that annother user won’t get into your account area. Hit the START
menu in the lower left-hand corner, select ShutDown, then click Shut Down the computer.

5. Using Email
How you should handle your Email depends on whether you read it in one of the Labs or on your own
computer.
• On your own computer, Eudora Pro (or Eudora light if you have little disk space) is probably the best
program to use.
• If you log on from one of the labs, you may use Pine but it is better to Install Eudora Light on the H
drive. You will need Eudora Light to download and send attachments — see below.
Go to the Help Desk in the PAC Data Lab or the first floor of the Science Tower for information about
setting up Eudora — its free.
• Attachments
You will want to be able to process Attachments on Email that you receive. Someone may send
you a Greeting Card from San Francisco attached to an Email message. Someone may want to send you a
copy of a paper they have written —they can send it to you in Word format by attaching the file to an
Email message. And in Econ 280 we will occasionally send you Excel files and other materials attached to
an Email message.. When I use Eudora the attachments automatically get dumped in C:\Eudora\Attach.
If you have Eudora on the H drive, you might the files in H:\Eudora\Attach

6. Reading PDF Files
Many files on the NET are in PDF format, such as Syllabus.PDF off of the E270 Home Page.
When you click on links to such files from any of the ITS Computer Labs the computer will automatically
load Acrobat Exchange and display the file for you. You can enlarge the file to make it more readable, if
you like. You can print out the file, but you should use the little icon on the left of the Adobe File tool bar
as the on the big Netscape Print Icon has been know to crash the program.
If the program isn’t on your computer, you can get it for free using Netscape by going to
http://www.adobe.com/prodindex/acrobat/readstep.html. First follow the instructions to download the
program onto your C drive (remember the location on your C drive). Second, use Windows Explorer to go
to the location where the file was downloaded and double click on it. The program will self install.
Finally, delete the downloaded file from your C drive.

7. Using EXCEL’s Statistics/FREQUENCY Function
This function is tricky to use because the results go in an array rather than in a single cell – It is an “Array Formula.”
Before you try to activate it you must block a column array that is one cell longer than the Bin Array. After you have
specified the Data and Bin Array, DON’t click done (That’s a bug in EXCEL). Instead you must hit Ctrl-Shift-Return
because it is an Array Formula!
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8. Excel Graphs:
When you pretty up your bar graph you will want to have the units of measure (e.g., height in inches) indicated under
each bar. You can do this by clicking on the Series Tab of the Source Data Menu. Put in the location of the labels at
the bottom in the box called Category (X) labels:”

9. Regarding Symbols in Word:
Use TOOLS/AUTOCORRECT to automatically insert symbols. To do this from the symbols menu, select
your symbol (e.g. β) and then click the auto-correct box. Give it a name (e.g. beta); then whenever you type “beta ” it
will be auto-corrected to the symbol β.

10. Double-space in Word
To double space an entire document in Word 6 and later, first Ctl-A to select the entire document then Ctl-2
to double space.

11. Re Problem Set #1:
The cum(q) column on the table of question 1 reports the cumulated percentages. For example, the 32%
indicates that 32% of the series ended on either the 4th or the 5th game. Similarly, the 100% indicates that all series
ended on or before the 7th game.
The table of SAT data provided as an extension of this problem set has all the work done for you, almost.
The table is laid out like the table on page 1 of the first problem set about the world series, except that the random
variable is x. Thus p is the proportion in each category and the sum px is the mean!
#5: The sum I = 1 to 3 of 2 says to add up the stuff on the right of the equals sign, items 1 to 3, since these
are all =2 we have 2+2+2 = 6
Similar, summation Xbbar for I = 1 to n is nxbar.

12. Data Source
Kurian, George Thomas, Datapedia of the United States, 17890-2000, America Year by Year, Bernan Press, 1994

13. Re the position of math equation objects in Word:
If the images generated by equation editor are not lining up on the line correctly in Word, try right-clicking
on the equation, selecting “format object, click” on the Position tab, and then click off the "float over text"
button if it is on.

14. EViews
EViews recommends that you use the clipboard to copy data from Excel spreadsheets and other sources (e.g. Window
based CD-ROMs). Use EViews Help and search for Clipboard to find out how.
Here are the basic steps:
1. Go into Excel, select the data that you want (the data must be laid out with the variables in successive columns,
names of the variables in the top row followed by the observations in successive rows.
2. The names of the variables must be legal in EViews (no more than 16 characters; MOTHER is a reserved word so
substitute MOM and DAD)
3. Next start EViews and create a new workfile (File/New from the main menu), or load an existing workfile
(File/Open from the main menu). Select the appropriate frequency and start and end observations (e.g., irregular,
30). Make sure the sample is set to include the same observations that you have copied from Excel.
4. Select Quick/Empty Group and a group spreadsheet window opens.
5. The spreadsheet opens in edit mode so there is no need to click the Edit +/- button. If it were not in edit mode
there would be no white edit box directly under the Menu Bar.
6. You must scroll up one row to make room for the series names. Simply click on the up arrow in the spreadsheet
scroll bar.
7. Place the cursor in the upper-left cell, just to the right of the word obs. Then select
8. From the main menu and your variables will be added to your work file.
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15. Using the IMF Data Base
1.

2.

3.
4.

The first step is to consult a recent issue of International Financial Statistics, a monthly publication of the
International Monetary Fund (the October 1988 issue is on reserve as ZZPDL MANUAL IFS 1998 OCT but it is
better to look at a recent issue in the periodical room). Pick out the data you want (but note only the most recent
years are reported in the hard copy publication) and make a note of both the country code (at the top of the page
under the country name; e.g. Tanzania is 738) and the time series code (e.g., 99c is exports of goods and services).
Get the latest available IMF CD-ROM (e.g. ZZPDL CD-ROM IFS 1997/12) The software is old. It’s a dos
program that apparently will not work in a NT machine; you must use a WINDOWS PC! Further, it apparently
will not run unless your CD-ROM drive is assigned as Drive D.
You must install the software on the computer by clicking on the INSTALL program on the D drive. Because the
program changes every month, you must be sure to install the version on the particular CD-ROM that you are
using.
Once you see this DOS program you will really appreciate Windows! You will probably need help from a data
lab assistant or someone who has run the program before. Try following the instructions for specifying the time
period you want data for, the countries you want it for and the variables by entering the appropriate codes. Then
You will want to save the data on a floppy disk in drive A: or on your H: drive.

16. World Development Indicators:
A wonderful compendium of data from the World Bank. It is a Windows based program. Running SETUP.EXE
establishes a program group named WB Development on the computer.
It contains 26 years of data!
Country: Botswana (BWA)
You can “copy/paste” data from the tables on the CD-ROM into an EXCEL spreadsheet or into EViews, if you have a
single table with and variables in successive columns with one observation per row
the "WDI1997 CD-Rom"icon and access the program. Once in the program, we
can start collecting data by clicking on the "Query" menu button and
specify
countries, series and years respectively. For each category, the easiest
way to pick up data is to choose the items we want and double click them
(for consecutive itmes, block and double click). If we have all the
specifications of countries, series and years ready, click on OK and a
worksheet will appear. Note that it might not be of the same orientation
as you desire and we can adjust that by choosing from the Orientation menu
at the bottom. For example, if we want the series down and countries
across for a particular year, we can choose from Orientation menu. The
worksheet can only be two-dimensional, and the other dimension (eg.,
years) will be in the menu in the upper part of the screen.
For exporting data, there is a small icon in the upper part called "export
data". If we click on it, there will be several choices. Choose Excel
datasheet and properly specify all other parameters and click on OK, the
program will automatically translate the original worksheet into formatted
Excel file. Finally, we are given choices of where we want to save the
file and naming the file.

17. Downloading Data from the Internet for processing
Downloading data from tables on the Internet for processing by Excel or EViews. You cannot copy/paste, but here is
the trick. When it is displayed in Netscape Communicator, Click on File/Save as an *.HTML file and save it on your
hard disk (Open the HTML file you have created in EXCEL and it will automatically load it into a table. Clean up the
data and, if desired, copy/paste into EViews.

18. Mathematica
Putting Headers on your Mathematica output. To have your name or other information printed at the top of the page
when you print out your Mathematica file you select File/Printer Settings/Headers and Footers and place the desired
information set inside quotes in the Centered Edit Box.
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Netscape Communicator

Downloading data from tables on the internet for processing by Excel or EViews. You cannot copy/paste, but here is
the trick. Click on File/Save in Netscape Communicator and save the file on your hard disk (it will have file extension
.xls. EXCEL will load the file properly. If desired, you can copy/paste the data into EViews.
20.

Creating PDF file

Log into Australia in the PAC Data Lab: .mlovell.econ.wu. (don’t worry about context)
Open Word
Load file into WORD, under file menu select
CreateAdobePDF
Via PDF Window
This will save it back on the disk

21. Excel Output to the Printer:
You will need to send your output to the printer when you are done. Before sending the file to the printer, you must use
print preview to make sure that it is printing out appropriately.
You can adjust the rows and columns covered by the printer by selecting with your cursor the rows and column block
you want to print, clicking on the File pull down menu in Excel, and then choosing the Print Area option.
You can adjust the number of pages required for your printout by selecting the Setup option while in PrintPreview.
Select page and then adjust to 75%, say of normal size in order to squeeze more on a page. Or use the Fit To Pages
option.

22. Posting and Downloading Excel Files on Your Home Page
Excel files have the extension .xst. If such a file is posted on the net, a user who clicks on it will have the
option of downloading it onto their computer or processing it with Excel, if it is available on their
comptuter.

23. Some Useful Websites
Web site for accessing Fed in Print on the Internet: http://www.libertynet.org/~fedreserv/fedpage.html
State of New York Board of Education: http://www.nysed.gov/emsc/
Government Information Sharing Project: http://govinfo.kerr.orst.edu/
Connecticut Public Expenditure Council: http://www.cpec.org/default.html
ISGUTS Home Page http://www.wesleyan.edu/~aisgut/econ280/fall98/

24. Installing Eudora Light on Your Network Drive
Module 1 in Econ 280 requires you to install Eudora Light (an e-mail program) on your
H drive. In order to setup this program:
1. Log on to the network on a PC running Windows 95 or 98 in your room or in a
computer lab on campus. (Note – this can also be done using a Macintosh computer
running Virtual PC, such as those located in SC 72)
2. Go into Windows Explorer and click on the X drive.
3. Find the folder in the X drive titled "Elight" and select the folder (it should then be
highlighted).
4. With the folder highlighted, go to the Edit menu and select "Copy."
5. You must now find your H drive and open your home directory on this drive. (Note -your home directory is usually specified by your first initial and last name)
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6. Once in your home directory go to the Edit menu and select "Paste." The folder
"Elight" should now appear in your home directory.
7. Open the folder "Elight" and run the program Eudora (the icon should appear to be a
mailbox). YOU DO NOT NEED TO RUN THE INSTALL PROGRAM!
8. If this is the first time running Eudora on your H drive, then a form will appear and
prompt you for various information. In the field titled “POP account,” simply enter your
full e-mail address (i.e. asmith@wesleyan.edu). You must also enter your real name
where prompted.
9. THE FOLLOWING STEP IS VERY IMPORTANT!!! You must go to the category
"Checking Mail" which should appear as an open mailbox on the left-hand side of the
screen. Click on the box "Leave Mail on Server." An "X" should now appear in the box
next to that option. You may now click the OK button on the bottom of the screen.
(Note -- If you have already setup Eudora but do not know if you did this step correctly,
then go to the Special Menu and select "Settings." You must then follow step 9).
10. To check your mail, go to the File menu and select "Check Mail." It will then prompt
you for your e-mail password, which you should enter and then click OK.
TIP -- To eject a floppy disk on the Virtual PCs in SC72, hold down the apple key (next
to the space bar) and press "1."
For more information on Eudroa consult the San Francisco State University Handout:
http://userwww.sfsu.edu/~training/eudora.pdf

25. Lexis-Nexis
Lexis-Nexis is a full text database that provides a vast amount of online legal, news and business
information services. Lexis-Nexis provides users with information from many different sources.
Current news topics and issues, as well as articles archived up to twenty years can be accessed
from such sources as the New York Times, the Hartford Courant, the Economist. In addition,
information about individual companies, industry and market news, government and political
news, country and state profiles, biographical information, legal issues, and much more can be
retrieved. Lexis-Nexis can be accessed from any computer connected to the Internet on the
Wesleyan campus.
To connect with Lexis-Nexis:
1. Open a web browser (such as Netscape) on any computer connected to the Internet on the
Wesleyan campus.
2. Go to the Wesleyan Library homepage. This is found at the address:
http://www.wesleyan.edu/libr. The page can also be accessed by going to the Wesleyan University
homepage (http://www.wesleyan.edu), clicking on “Campus Resources” and then clicking on
“Library.”
3. From the library homepage, click on the link for “Indexes, Abstracts, & Databases.”
4. Once this page has loaded, scroll down through the alphabetized list of services until you find
“LEXIS-NEXIS.” Clicking on the button labeled “connect” will begin the session.
To use Lexis-Nexis:
1. Upon connecting to the Lexis-Nexis database, a page will open that provides 20 general
topics, which represents the various services provided. This page does provide brief
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descriptions of the information offered by each category under “Search Form Descriptions &
Source List Information.” Click on the link that is most likely to include the information you
are trying to retrieve.
2. A form will now appear that can be filled out with the details of your request. For example, if
you choose General News Topics, you will be prompted to enter a Keyword or Byline,
Additional Terms, Source Material, and Date.
• Keyword refers to words or phrases that describe your topic of interest.
• Byline allows you to search for articles by particular authors of interest.
• Additional Terms is an extension of the Keyword/Byline fields.
• Source Material allows you to specify the resources you wish to search, such as all
major newspapers or only European news sources.
• Date allows you to indicate a particular range of dates to limit your search.
3. After completing the provided form, click on “Search.” The page that appears will show the
results of your inquiry. If you see the error message, “No documents were found for your
search,” click the “Back” button on your browser and edit your search parameters.
Otherwise, Lexus-Nexis will report the number of documents at the top of the screen and list
the titles and sources of every hit. If more than 25 hits are found, it will be necessary to click
on “Next Results” and “Previous Results” to maneuver through your result list.
4. Clicking on the link for any individual hit will bring up that particular article in its entirety.
You can maneuver throughout the documents and result list by clicking on any of the choices
located at the top or bottom of the page, such as “Results List,” “Previous Document” or
“Next Document.”
Note – At the bottom of the Search Form page is a section titled “General Search Tips.” This
area is extremely useful since it provides a brief description of important search techniques, such
as Boolean connectors and universal characters. Utilizing these tools helps create much better
search results and can save you a lot of time!

